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Abstrakt

Tato diplomova prace se zabyva tvorbou dil¢i dokumentace podloubi domi
&. p. 504 — 512 v Havelské ulici v Praze 1 pro Narodni pamatkovy astav. Uvodem prace
informuje o historii zaméfovanych objektd. Zamysli se nad pouzivanymi metodami
zaméfovani historickych objektd. Déle popisuje pracovni postup terénnich
i kancelaiskych praci. Obsahuje porovnani dvou oblouki kleneb loubi domu ¢&. p. 507.

Na zavér komentuje dosazené vysledky a ptesnost méteni.

Klicova slova

Laserové skenovani, bodové mra¢no, méficka dokumentace, podloubi, porovnani

bodovych mrac¢en, 3D model, CloudCompare, Bentley MicroStation, Leica BLK360



Abstract

This Master's thesis focuses on the completion of a partial documentation of the historical
archway of houses No. 506-512 in Havelska street, Prague 1 for the purposes of the
Narodni pamatkovy ustav. In the thesis, both working procedure and office work are
described. In the first part, the study mentions the history condition of the measured
objects. It deals with the methods used for the measures of the historical objects. Also, it
describes the steps of the workflow. It contains the comparison of two arcades of building
no. 507. The last section of the thesis focuses on the results and the measurements'

accuracy.

Keywords

Laser scanning, point cloud, surveying documentation, archway, point cloud comparison,
3D model, CloudCompare, Bentley MicroStation, Leica BLK360
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% CESKE VYSOKE UCENI TECHNICKE V PRAZE

Uvod

Touto diplomovou praci bych chtél navazat na piedchozi bakalafskou praci
a spolupraci s Ing. Jindfichem Hoda¢em, Ph.D., pod jehoz vedenim jsem bakalaiskou
praci zpracovaval. V bakalarské praci jsem si osvojil zpracovani dil¢i dokumentace

fotogrammetrickou metodou. Vystupem bylo mra¢no bodt, 3D model s texturou

a ortofotosnimky. Vysledny model byl nasledné¢ vytistén na 3D tiskarné.

Dalsim zptisobem, jak ziskat mra¢no bodu, je laserové skenovani. Béhem studia jsem
m¢l moznost seznamit se se skenovanim jen teoreticky. Pandemie, ktera nastala,
znemoznila praktické ukazky a vyzkouSeni skenovéani. Rozhodl jsem se tedy vyuZit
diplomové prace k ziskani praktickych a cennych zkuSenosti pfi zpracovani skenil a
mracen do podoby vykrest. Béhem praxe ve firm¢ H.C.M. s.r.0., kterou jsem absolvoval
pii studiu, jsem mél mozZnost vyzkousSet si skenovani jednoduchych stavebnich objektti a
nahlédnout ke tvorbé vykrest. Historické objekty maji naproti jednoduchym rodinnym
domtm c¢lenit€jsi tvary, specifické konstrukce a prvky. Jednim z mych osobnich cill je
tyto konstrukéni prvky poznat a mit moznost seznamit se s nazvoslovim téchto
jednotlivych prvkl a zplisobem zobrazeni prvki ve vykresech. Dal§$im mym osobnim

cilem je ovéfit si znalosti ziskané béhem celé¢ho studia.

Cilem této diplomové prace je vhodn€ zvolenymi metodami ziskat data a nasledné je
zpracovat do podoby vykresti padorysu a podélného fezu loubi doma ¢. p. 504 — 512
v Havelské ulici v Praze. Dalsim vytyCenym cilem je porovnani obloukt kleneb loubi
domu ¢. p. 507. Vysledné vystupy jsou tvoieny pro téely stavebné historického prizkumu
doc. Ing. Michaela Rykla, Ph.D. a NPU.
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% CESKE VYSOKE UCENI TECHNICKE V PRAZE

1. Lokalita
1.1Praha 1 — Stare Mésto

Staré Mésto je historické mésto, méstska Cast a katastralni uzemi Prahy na pravém
bfehu VItavy. Na severu a zapadé uzemi Starého Mésta ohranicuje feka Vltava, na jihu

a vychod¢ Staré Mésto sousedi S Novym Méstem. Svym tzemim zcela obklopuje

nejmensi prazskou  Ctvrt o
Josefov. Diive se meésto WHRAD?EY
nazyvalo  Mezihrady — = g 2
poloha mezi Prazskym Bf‘» -
hradem S ° wak ;
P etRana i
a VySehradem. Staré Mésto w
vzniklo spojenim Zidovské . -1
osady a n&kolika osad, které =
byly budovany  kolem © 2o d :
kosteld SV. Petra, o |

Obrdzek 1 — Uzemi Starého Mésta
sv. Michala a sv. Linharta. [1]

1.2 Havelska ulice

Sa/vato,

’§

Havelska ulice, ulice Starého 'K/”\')e\" G Mg Qen b ’ A H E\MF&TJM 853
Mésta v Praze, spojuje Zeleznou o \4«*‘_,‘
ulici s Uhelnym trhem. Ulice je = aexézové"” S92

znama Havelskym trhem, ktery s
navazuje na historii ptivodniho tzv. 9k8

Nového trzisté, které bylo jadrem ems"é g

tehdejsi Havelského Mésta. Staré {Z S s'/" . < e
7% ANLZ USt
A e V\ £ Q/m‘b? [ \ \\Q/

Obrazek 2 — Poloha Havelske ulice

a Havelské mésto spojila zastavba
domd, ktera se rozvinula predevsim

v 17.-18. stoleti. [2]

11
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1.2.1 C. p. 504/5
Diim U Mrazi

,Jde o ptivodné rané goticky vézovity diim,
ktery prosel renesanénimi prestavbami a byl
r. 1808 Z. Fiegerthem klasicistné¢ upraven. Dim
byl puristicky prestavén v 1. 1928 — 29
Bohumilem Steigenhoferem, ktery mimo jiné

nad domem vyzdvihl dvoupatrovou néstavbu.*

(3]

1.2.2 C. p.505/15
Dim U Zlaté riize (U Cerné hlavy)

,» T rojpatrovy fadovy dim je v jadru goticky, byl
barokn¢ piestavény. Dnesni vzhled je klasicistni JL
zr. 1829.“ [4]

Obrazek 4 — Dum U Zlaté rize

1.2.3 C p.506/13 a507/11
Domy U Teplych a U Modrého Iva

,Jde o dva spojené domy stfedovékého
puvodu. Levy byl pfestavén renesancné, pravy je
barokni. Spojeny byly po roce 1804. Poté byly
r. 1810 upraveny do dnes$ni klasicistni podoby

Zachariem Fiegerthem.* [5]

bréze 5- Dou T eply a ‘
Modrého Iva

12
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1.24 C. p.508/9
Dim U Radnickych

,»Z puvodné gotického objektu byla dochovana
pouze prucelni zed a loubi, zbytek domu byl
nahrazen novostavbou postavenou podle planu
T. Prazaka a P. Moravce z let 1929-31.“ [6] , _ Jie

Obrazek 6 — Dum U Radnickych

1.25 C. p. 509
Dim U Finki (U Ceské koruny)

., Radovy diim s podloubim je v jadru goticky, byl
renesancn¢ prestavovan. Ma ran¢ klasicistni fasadu
z doby pied r. 1800. Upravy z r. 1867 zvysily dvorni
kiidlo o druhé patro. [7]

Obrazek 7 — Duim U Finkui

1.2.6 C. p.510/5

Dim U Kutoveu

»Rang goticky dim, ktery byl ran¢ renesancné
pfestavén a 1803 klasicistné upraven J. Zelinkou. ;\
Diim si zachoval sttedoveké jadro v dispozici sklept -
1 pfizemi. V r. 1960 prob¢hla dle planu K. Hilberta .

uprava hlavniho praceli.” [8]

Obrazek 8 — Dum U Kutovcit

13
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1.2.7 C. p.511/6
Dim U Zlaté vahy

,Dum je v jadru goticky, renesan¢né upraveny.
Kolem r. 1690 byl radikdln¢ rané¢ barokné
prestavény. V 1. 1929-32 bylo vestavéno podkrovi za .
baroknim S§titem a dvorni staveni byla zbofena

a nahrazena novostavbou.* [9]

Obrdzek 9 — Diim U Zlaté vahy

1.2.8 C. p.512/2
Diim U Isidoru

»Itipatrovy dim vznikl spojenim dvou
samostatnych, v jadru sttedovékych objektt. Johann
Kaura v r. 1845 uz spojeny dim radikaln¢ pfestavél §

v piizemi a znovu vystavél od 1. patra.* [10]

Obrdzek 10 — Dim U Isidorii

14
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2. Metody zamerovani historickych objektii

Tato kapitola popisuje zakladni metody pouzivané pti zaméfovani historicky staveb
a objektt. Uvadi konkrétni priklady praci, které vyuzivaly jednotlivé metody nebo jejich

kombinaci. V zavéru kapitola shrnuje metody vyuzité v této diplomové praci.

2.1 Geodeticke metody

2.1.1 Metoda omérna

Omérnou metodou Ize oznacit pfimé méfeni délky mezi charakteristickymi body
objektu na jedné poloze métidla — pasma. Charakteristické body pod i nad urovni métidla
se provazuji olovnici. Tato metoda je vhodna pro zaméfeni mensich a spise pravidelnych
staveb. P¥i praci na vyssi Grovni piesnosti tato metoda slouzi jako dopliikova. Casto se

pomoci omérnych mér kontroluje jiné méteni, napf. méfeni polarni metodou. [11]

Tuto metodu vyuzila napiiklad Lenka Kroupalovd ve své bakalaiské praci
Geodetické zaméreni zvonicky Cirkve Cceskoslovenské husitské v Kostelni Lhoté
a prilehlého okolniho pozemku pro zameieni vnitini vysky sttechy, vzdalenosti vybézka
a dvefi v ptizemi kaple. [12] Lukas Hort v bakalaiské praci Zaméreni casti stredovekého
opevneéni ve Slaném vyuzil omérné k ziskani chybéjicich dat z laserového skenovani. Pfi
vektorizaci mrac¢na bodi bylo zjisténo, Ze ¢ast hlavni hradby obsahovala naskenovanou
vegetaci, ktera zakryvala povrch hradeb. Skute¢ny pribéh povrchu hradeb byl

dokonstruovan pomoci omérnych. [13]

2.1.2 Metoda ortogonalni

Zakladem ortogonalni metody je méticka ptimka. Poloha charakteristickych bodi
stavby se urCuje spusténim kolmice z bodu na méfickou pfimku. Méfi se vzdalenost
od pocatku ptimKky k paté kolmice a délka kolmice. Metoda se ¢asto pouziva pii zaméfeni
¢lenitych ploch fasad, kdy Ize vyuZit pravého uhlu mezi svislymi a vodorovnymi prvky.

[11]

15
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2.1.3 Metoda polarni

Dalsi geodetickou metodou je metoda polarni. Tato metoda se vaze na uzivani
presnych teodoliti a totalnich stanic. Méfeni polarni metodou se sklada z méfeni
horizontélnich i vertikalnich uhld a Sikmé délky. Metoda vychazi ze znalosti soufadnic
stanoviska. Méfici pristroj je zhorizontovan a zcentrovan nad bodem stanoviska. Béhem
meéfeni jsou zaméfeny orientace a podrobné body. Méfené hodnoty jsou zapisovany
do zapisniku méfeni nebo ukladany do vnitini paméti ptistroje. Z naméfenych hodnot
jsou vypocteny uthly mezi orientaci a podrobnymi body, ptfipadné¢ vodorovné délky.
Pro vypocet soufadnic podrobného bodu jsou tedy potteba zmétena vodorovna vzdalenost
a levostranny uhel vypocteny mezi orientanim smérem a podrobnym bodem.
Pro vypocty soutfadnice Z je potfeba znat vysky stroje a cilii. Ze znamych soufadnic
stanoviska a orientace je vypocitin smérnik. Pomoci smérniku, vypocitaného
vodorovného thlu a vodorovné vzdalenosti jsou vypocitané soutadnicové rozdily
podrobného bodu vici stanovisku. Pfi¢tenim soufadnicovych rozdili k soufadnicim

stanoviska ziskame vysledné soufadnice podrobného bodu. [11]

Princip polarni metody:

Znamé hodnoty: +Y

Y, X soutadnice bodu S a O, vodorovna
délka dsp, vodorovny uhel o,

vypocteny smérnik a,p

a:O'OP‘l‘(U,

AYOP = dop - sin a,

AXOP = dOP *Cos«a,

Yp = Y + AYpp,
oS T oor Obrdzek 11 — Princip poldrni
Xp = XS + AXOP' metOdy

+X

Polarni metodu vyuzil napt. Bc. Radek Novotny ve své diplomové praci Kostel
Stéti sv. Jana Krtitele Dolni Chabry (Praha) — dil¢i méricka dokumentace K zaméfeni
identickych bodi pro tvorbu fotoplant. [14] Anton Igonin vyuzil tuto metodu k zaméfeni

podrobnych bodi, pomoci kterych v ramci své bakalaiské prace Geodetické zamereni

16
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a vytvoreni 3D modelu modeloval 2D prototyp Leopoldovy brany na prazském
Vysehrad¢. [15]
2.1.4 Nivelace

Nivelacni méteni slouzi k ziskani Z-ové soufadnice méfenych podrobnych bodu
a tim umoziuje méfend data pripojit do zadaného vyskové systému. Vysky se mohou
vazat k mistnimu vySkovému systému nebo ke statnimu vyskovému systému Balt
po vyrovnani (Bpv) nebo dfive pouzivanému Jadersky. Pomoci nivela¢niho pfistroje
anivelacni laté se méfi prevyseni — relativni nejkratsi svisla vzdalenost bodu od horizontu
pfistroje. Méfeni vzdy vychdzi od bodu se zndmou vySkou. Méfeni se zapisuje
do méfického zapisniku nebo u novéjsich elektronickych piistrojii se zapisuje do vnitini
paméti pristroje. S nastupem totalnich stanic byva ¢asto nivelaéni méfeni nahrazeno
méfenim zenitovych 0hlG pfi méfeni polarni metodu. [11] Existuje nékolik druhid

nivelacnich méfeni, které se lisi pfesnosti méteni vyskovych bodi.

Druhy nivelace Piesnost

Technicka nivelace mo > 5mm

Pfesna nivelace I,5mm<me<5mm
Velmi piesna nivelace 0.4 mm<mpg<15mm
Zvl1ast presna nivelace mo< 0,4 mm

Tabulka 1 — Druhy nivelace a jejich presnost

Metodu technické nivelace vyuzila napiiklad Bc. Barbora Vasova v ramci své
diplomové prace Novoméstska radnice v Praze — meéricka dokumentace Mdazhausu
K ptipojeni objektu do vyskového systému Bpv. Obousmérné vedenym nivelaénim
pofadem byl nejprve ovéfen vychozi bod, ze kterého byl nasledné veden uzavieny
nivelacni potad pies body polygonového pofadu. Za ¢elem pripojeni do systému Bpv byly

bocné zaméfeny 3 body. [16]

2.2 Laserove skenovani

Laserovym skenovanim miiZzeme nazvat metodu bezkontaktniho, nevybérového,
automatického sbéru dat pomoci 3D skeneru. Skenery miizeme délit na statické, mobilni

a rucni. Pii tvorbé dokumentace historickych objekti se vétSinou pouzivaji skenery
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statické. Tyto skenery vyuzivaji méteni délek a horizontalniho a vertikalni uhlu, ktery
svira paprsek se smérem nulové orientace skeneru. Vysledkem skenovani jsou 3D
soufadnice XYZ hustého mra¢na bodu viditelnych ze stanoviska skeneru. Spolu se
soufadnicemi skener muze ukladat i informaci o barvé v podobé RGB hodnot nebo
sférické snimky, které béhem skenovani na stanovisku nafoti. Jednotliva naskenovana
mra¢na mohou byt spojena metodou optické korelace nebo pomoci vlicovacich boda
(kouli, ter¢ir). Diky neznalosti soufadnic stanoviska jsou mrac¢na umisténa do obecného

mistniho systému, vlicovaci body mohou slouzit i ke georeferencovani mracen. [11]

Laserové skenovani pouzil naptiklad Ing. Luka§ Hort ve své bakalaiské i diplomové
praci k zaméteni historickych objekti ve Slaném. K zaméfeni podrobnych bodt, pomoci
kterych ptipojil naskenované mra¢no do soutadnicového systému S-JTSK, pouzil polarni

metodu. [13], [17]

2.3 Fotogrammetrie

Fotogrammetrie je ¢ast oboru geodézie a kartografie, ktery se zabyva zjistovanim
geometrickych a  polohovych informaci zobrazovych zaznami, nejcastéji
zZ fotografickych snimkl. Vyhodou fotogrammetrie oproti klasickym geodetickym
metodam je vyrazné rychlejsi terénni ¢ast prace a veétsi zachyceni reliéfu povrchu stavby
1 barevnad informace. Podle zplisobu snimkovani mizeme fotogrammetrii rozdé€lit na
pozemni a leteckou. S nastupem RPAS se letecka fotogrammetrie stava jesté dostupnéjsi.
Velmi ¢asto se kombinuje snimkovani ze zemé profesionalni kamerou a z vysky pravé
pomoci RPAS. Dale se fotogrammetrie déli podle poctu pouzitych snimka
na jednosnimkovou a vicesnimkovou. Vicesnimkova fotogrammetric se dale déli
na stereofotogrammetrii, priasekovou fotogrammetrii a na metodu obrazové korelace

(anglicky nazyvana image based modeling).

Jednosnimkova fotogrammetrie je nejjednodussi fotogrammetricka metoda, ktera
umoziuje dokumentaci rovinnych objekti. Upravuje fotograficky snimek pomoci
kolinearni transformace tak, aby minimalizovala obrazovou deformaci na snimku.

Snimek se co nevice pfiblizuje pravothlému prumétu vychozi rovinné plochy. [11]
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Vystupem této metody je fotoplan. Tvorbu fotoplanu popisuje ve své diplomové praci

Bc. Barbora Vasova. [16]

Jednim z vystupt vicesnimkové fotogrammetrie je tzv. ortofoto. Ortofoto je snimek
upraveny ze stfedového promitani do ortogonalni projekce. DalSimi vystupy
z vicesnimkové fotogrammetrie mize byt mracno bodi a 3D model. Tvorbou ortofota,
3D modelu a mra¢na bodti pomoci metody obrazové korelace jsem se zabyval ve své
bakalatské praci Kaple BozZiho hrobu ve Slaném — fotogrammetricka dokumentace.
Ortofoto bylo vytvotfeno z otexturované¢ho 3D modelu kaple. Model byl vytvotenou
metodou obrazové korelace v programu Reality Capture ze snimkt nasnimanych pomoci
RPAS. [18]

Z vyse zminénych praci je vidno, Ze se ¢asto jednotlivé metody kombinuji a dopliuji.
Jedna metoda se d4 pouzit ke kontrole druhé nebo jeji pomoci zaméfit oblast, ktera byla

pro druhou metodu nepfistupna.

Laserové skenovani se jevi jako nejvhodnéjsi pro ziskani celistvych dat celého loubi,
ze kterych zpracovatel nasledné muze Cerpat a vybirat jen ta potiebna K vytvoreni dalsich
vystupti. Nevyhodou skenovani je prace s objemnymi daty. Prace je tedy nérocna

na vypocetni techniku i na samotné tlozisté.

Dalsi metoda vhodna pro ziskdni mra¢na bodt nebo vytvofeni modelu je
fotogrammetrie. V zaméfovaném loubi je malo pfirozeného svétla a celkové obsahuje
tmava mista. Tato metoda je pro zadany objekt nevyhodna svou délkou zisku a potiebou

umeélého osvétleni.

Jednim z pozadavkl bylo ptipojeni do vyskového sytému Bpv. Pro tento tcel byla
zvolena technické nivelace, ktera je vyhodna rychlosti zisku vySek za dostate¢né presnosti

méfeni. Polohové piipojeni nebylo od zadavatele vyzadovano.
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3. Mericka dokumentace

Metickd dokumentace patii mezi hlavni a nepostradatelné slozky praktické
pamatkové péce 1 veédeckého vyzkumu historické architektury. V praxi casto
dokumentace byva nesouroda, obsahuje neptesnosti nebo zcela chybi. Jen s velmi
kvalitné zpracovanou méfickou dokumentaci lze spravné projektovat, posuzovat
vhodnost ¢i nevhodnost navrhovanych zasahii nebo vést védeckou ¢innost. Zhotoveni
dokumentace historické stavby klade naroky na zhotovitele, ale i na zadavatele. Spravna

komunikace mezi obéma stranami je zakladem Gspé$né a kvalitni prace.

Meéftickd dokumentace se déli na dil¢i a celkovou (komplexni). Pro komplexni
dokumentaci plati, Ze by méla piehledné a dostate¢né zobrazovat dokumentovany objekt.
Dil¢i dokumentace by méla obsahovat alesponi celkovy schématicky plan objektu

s vyznacenim lokélnich ¢asti, kterych se dil¢i dokumentace tyka.

Hlavnim vystupem méfické dokumentace byly, a nadale jsou, 2D vykresy pudoryst,
pii¢nych i podélnych fezli, pohledy na vSechny pruceli a fasady vzdy upravené dle
pozadavkt objednavatele a problematiky zobrazovaného objektu. S nastupem novych
metod 1 pfistroju tyto vystupy doplnily vystupy digitalni. Pfedev§im se jedna o mracna
bodii, ortofotosnimky, fotoplany a 3D modely. Nevyhodou téchto novych vystupt jsou

objemna data, kterd musi zadavatel uchovavat.

V této kapitole cerpdano z [11].
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4. Pouzité pristroje a pomiicky
4.1 Laserovy skener Leica BLK 360

Laserovy skener Leica BLK 360 je pozemni 3D skener s integrovanym sférickym
obrazovym systémem a termografickym panoramatickym snimaem. Pulzni,
vysokorychlostni systém meéfeni délek vyuziva vinovou délku 830 nm. Délky méri
S presnosti 4 mm / 10 m nebo 7 mm / 20 m. Jedna se 0 rozmérové maly a lehky skener,
vhodny pro vnitini i vnéj$i pouziti. Rozsah méteni je od 0,6 m do 60 m. Horizontalné

skener skenuje plné zorné pole, vertikaln¢ 300°. Skener je vybaven IMU jednotkou, ktera

ptistroj automaticky orientuje. Ovladani skeneru umoziuje jen jedno tlacitko.

B

Obrazek 13 — Skener pri méreni na
stanovisku

Pro nastaveni skeneru je nutné vyuZit integrovanou WLAN a ptipojeny pocitac nebo
tablet se systémem iOS. Rychlost skenovani je az 360 000 bodu za vtetinu. Lze volit mezi
ttemi typy nataveni rozliSeni — vysoké 5 mm / 10 m, stfedni 10 mm / 10 m a nizké
20 mm / 10 m. Vyrobce udava, Zze méteni jednoho skenu (plné zorné pole, sféricky a
termalni snimek) lze realizovat pod 3 min. Pii skenovéni skener signalizuje méftici stav
signalizaénim pruhem, ménici se barvou a typem signalizace. V baleni se dodava
s lehkym stativem, nabijeCkou a bateriemi. V§e je ulozeno do pfiru¢ni brasny, do které se

vejde i tablet. [19]
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Viaha 1 kg

Rozméry vyska: 165 mm, prumér: 100 mm
Vnitini pamét’ ulozisté pro < 100 stanovisek
Dosah méfeni 0,6 az 60 m

Piesnost méfeni délek 4mmnal0m/7mmna20m
Piesnost méfeni thla 40 (0,0123 gon)

Tabulka 2 — Technické parametry Leica BLK 360

4.2 Nivelacni pristroj Carl Zeiss Jena NI 020A

Carl Zeiss Jena NI 020 A je opticky nivelacni
pristroj. Misto stavécich Sroubt pfistroj disponuje
stavécimi kliny. Tento pfistroj je svou piesnosti

vhodny pro méfeni technickou nivealci.

4.3 Totalni stanice Trimble M3

Trimble M3 je lehka, kompaktni a vykonna
elektronickd totdlni stanice. Totalni stanice je
vybavena vnitinim prostiedim Trimble Access.
K ovladani stanice slouzi dotykovy QVGA displej,
klavesnice a nekone¢né ustanovky. Pfistroj mize
byt vybaven laserovym i optickym centrovacem.
Totalni stanice je nadale vybavena dvéma
za provozu vyménitelnymi bateriemi, se kterymi

zvladne pracovat az 26 hodin. Dalkomér umoznuje =

méfit bez pouziti hranolu aZ do vzdalenosti 300 m.

[20] Obrazek 15 — Totalni stanice Trimble
M3 na stanovisku
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Rozméry: 149 mm x145 mm x 306 mm
Vaha: 4,2 kg

Kompenzator: Dvouosy, rozsah £3,5°
Délka tubusu dalekohledu: | 125 mm

Zvétseni dalekohledu: 30x

Pfesnost méreni uhlu: 1,5 mgon

Ptesnost méfeni délek:

Mgéfeni na hranol + (2+2 ppm) mm
Bezhranolové méteni + (3+2 ppm) mm

Tabulka 3 - Technické parametry Trimble M3
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5. PouZzity software
5.1BLK360 Data Manager

BLK360 Data Manager je software od vyrobce Leica, dodavany ke skeneru Leica
BLK 360. Tento software slouzi ke komunikaci uzivatele se skenerem pomoci pocitace
nebo mobilniho zatizeni. Timto programem mize uzivatel nastavit parametry skenovani,
zjistit stav baterie skeneru, nastavit kvalitu snimku a stahnout nebo smazat jednotlivé
skeny z vnitini paméti skeneru. Vyrobce dale udava, ze uzivatel mize synchronizovat
interni hodiny skeneru s ¢asem na pocitaci, ke kterému je pripojen. Aby nedoslo ke ztraté
dat, stahovani jednotlivych skenii ze skeneru neni mozné, pokud stav baterie klesne
pod 20 %. Stazené skeny program uklada do formatu .blk. Program je ke stazeni zdarma

ze stranek vyrobce. [21]

[@ BLK Data Manager v 2020.0.0 b4

Q

Find & Connect Device

Battery Level:

Obrdzek 16 — Prostredi programu BLK Data Manager
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5.2 Leica Cyclone REGISTER 360

Leica Cyclone REGISTER 360 je softwarovy modul programu Leica Cyclone
slouzici ke zpracovani naskenovanych mrac¢en bodi. Kostrou programu je propracovana
databazova struktura, kterd umoziiuje rychlou préci s objemnymi daty. Program zvladne
vyfesit cely vypocetni proces od importu dat, registraci skenu, editaci mracen,
transformaci mrac¢na az po modelovani a export dat do riznych formata. Pro registraci
mracen je mozné vyuzit naskenované terCe, prekryty mracen, geodetick¢é metody
a vymodelované objekty. Leica Cyclone REGISTER 360 umoziuje automatickou i ru¢ni

registraci mracen. Veskera prace s daty probihd krok po kroku v ptehledném pravodci.

Havelska_2

& rimavize

WE R mql

é‘}omumze Bundle

Obrdazek 17 — Prostredi programu Leica Cyclone REGISTER 360

5.3 CloudCompare

CloudCompare je open-source program slouzici k praci s mra¢nem bodu. Nejprve
byl vytvofen pro porovnani dvou mracen bodi nebo mezi mraénem bodu
a trojuhelnikovou siti. Postupem c¢asu byl program doplnén a rozsifen na obecné&jsi
software pro zpracovani mracen bodi. Byly doplnény algoritmy umoziujici registraci,
pfevzorkovani, vypolet statistik, segmentaci nebo praci se skalarnim polem.
CloudCompare podporuje rozsifeni pomoci pluginti. Program podporuje velké mnozstvi
vstupnich i vystupnich formatd. Je vydan pod licenci GNU GPL a psan v jazyce C++.
[23]
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Obrazek 18 — Prostiedi programu CloudCompare

5.4 Bentley MicroStation V8i

MicroStation je CAD software vyvijeny firmou Bentley pro navrhovani ve 2D a 3D
prostoru. Software je vhodny pro architekturu, stavebni inzenyrstvi, zpracovatelsky
prumysl, vyrobni zafizeni, statni spravu a inzenyrské a telekomunikacni sité. Program
pracuje se svym vlastnim formatem vykresi .DGN. Vyhodou MicroStationu je podpora
i dalsich formatd. Plnohodnotné zvlada praci s DGN i DWG soubory. Veskeré prvky,
které uzivatel pii praci s DGN souborem umisti do soufadnicového systému se ukladaji
do tzv. modelt. Existuji dva typy modeli — vykres a arch. Vykres tvoii jednotlivé prvky.
Arch slouzi k ptipojovani referen¢nich vykresi a K finalnimu vyhotoveni vykresu. DGN
soubor tedy mulze obsahovat nékolik modelii, které jsou navzajem nezéavislé. Velkou
vyhodou prace s modely je jejich pfipojeni ¢i umisténi do jiného DGN souboru.
MicroStation nadale vyuziva referen¢ni pfipojeni vykrest. Tato schopnost umoziuje
ptipojit jakykoliv model do modelu jiného a pracovat s nim jako s prvkem vykresu.
Referenc¢ni ptipojeni se vyuZziva napiiklad pii findlni tvorbé vykresu a k naslednému tisku
(ptipojeni modelu typu vykres k modelu typu arch v ptislusném méfitku), pii konstrukcei
prvkd jako je fez, pudorys ¢i pohled (pfipojeni modelu typu vykres k modelu typu
vykres). [24], [18]
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Obrazek 19 — Prostiedi programu MicroStation

5.5Groma 12

Program Groma je geodeticky systém, ktery slouzi ke komplexnimu zpracovani
geodeticky dat. V programu lze zpracovavat méfeni z totalni stanice, seznamy soufadnic
1 rastrova data. Veskeré vypocetni ulohy probihaji v dialogovych oknech, ve kterych
uzivatel nadefinuje parametry ulohy a vstupni a vystupni soubory. Body ze seznamu
soufadnic lze také zobrazit graficky v grafickém okné€. Program plnohodnotné

spolupracuje s programy MicroStation a AutoCAD. [25]
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Obrazek 20 — Prostiedi programu Groma 12
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6. Terénni prdace
6.1 Priprava meéreni

Diky absenci i0S zafizeni bylo potfeba nastavit skener Leica BLK 360 v kancelafi.
Skener byl pfipojen pomoci WI-FI K pocita¢i. Veskeré nastaveni prob&hlo v programu
BLK360 Data Manager. Skener byl v programu nalezen a pripojen. Ze skeneru byly
smazany veskeré skeny. Hustota skenovani byla nastavena na stiedni hodnotu. Déle bylo

nastaveno potizeni HDR fotografie a nulova korekce expozice (OEV).

w BLK380 Capture Settings

Scan Deriih,r: Medium ~ Image: HOR ~ Image EV: 0

Obrazek 21 — Nastaveni skeneru

V portalu Geoprohlize¢ (https://ags.cuzk.cz/geoprohlizec/) v produktu Bodova pole
byly nalezeny nivelacni body okolo Havelské ulice. Celkem byly nalezeny 3 body
(B1-194.1, BI-194.2 a BI-195). Nivela¢ni udaje téchto bodu byly stazeny a pouzity

pii méfeni technickou nivelaci.

OQ g ° \\[ [
Z o)
= / ./\@/,\//(/'/h‘ia... ’
Obrazek 22 — Polohy vyskovych bodii zobrazené na portile Geoprohlizec

é
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6.2 Rekognoskace

Rekognoskace probéhla pied skenovanim dne 25. 2. 2021 za piitomnosti
Ing. Jindficha Hodace, Ph.D. a doc. Ing. Michaela Rykla, Ph.D. Na mist¢ byl definovan
rozsah zamétovaného uzemi, byly ukazany dulezité¢ konstrukéni prvky loubi a pfiblizné
urceny pozice jednotlivych skent. Déle se vytycily prekazky, které branily ke skenovani
dilezitych prvkl. Tyto prekazky bylo tfeba odstranit nebo pfemistit. Nasledné byly

nalezeny nivela¢ni body a zjistén stav stabilizace téchto bodu.

6.3 Laseroveé skenovani

Laserové skenovani probéhlo dne 25. 2. 2021. Ke skenovani byl pouZit jiz
piednastaveny skener Leica BLK360. Skener byl umistén na stativ a zapnut podrzenim
ovladaciho tlacitka. Zelené rozsviceni signalizaéniho pruhu oznamilo, ze byl skener
pfipraven ke skenovani. Béhem skenovani byl tvofen nacrt stanovisek skeneru. Hlava
skeneru byla pti kazdém skenu umisténa tak, ze ovladaci tlacitko smétovalo vzdy stejnym
smérem. Pied zapocetim skenu byl skener hrubé zhorizontovan posunem nohou stativu.
Samotné skenovani spustilo zmacknuti ovladaciho tlacitka. Skener nejprve otacenim
potidil sférickou fotografii a az nasledné skenoval. Cely priib¢h skenu doplnovalo zelené
blikani signaliza¢niho pruhu. Po dokonceni skenu signaliza¢ni pruh piestal blikat a svitil
zelené, pripraven k dalSimu skenovani. Skener byl piesunut na dal$i stanovisko a prob¢hl
dalsi sken. Stanoviska skeneru se volila tak, aby se naskenovana mracna Castecné
piekryvala. Celkem bylo vyhotoveno 60 skend. Doba jednoho skenu ¢itala kolem

3 mina40s.

Obrdzek 23 — Pozice stanovisek jednotlivych skenii
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6.4 Technicka nivelace

Pro vyskové piipojeni naskenovaného mracna do systému Bpv bylo provedeno
méfeni technickou nivelaci. Byl proveden jeden nivelaéni pofad mezi body 194.2 a 194.1,
pii kterém bylo bo¢né zaméfeno nékolik vyskovych bodu podél celého podloubi.
Vyskové body byly voleny na ¢epovych znackach, hranach soklti a na kamennych prazich
dvefi, které byly jasn¢ identifikované v naskenovaném mrac¢nu bodi. Dal§im nivelaénim
pofadem mezi body 194.2 a 195 byla ovéiena vyska bodu 194.2. K méfeni byl pouzit
opticky nivelaéni ptistroj Carl Zeiss Jena NI 020A s ptisluSnym stativem, nivelacni lati
a nivelacni podlozkou. Veskeré Cteni bylo zapisovano do zapisniku pro technickou

nivelaci (viz priloha Zapisniky technické nivelace.pdf).
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Obrazek 24 — Pribéh poradu technické nivelace mezi body 194.2 a 194.1
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6.5 Meéreni totalni stanici

M¢éienim polarni metodou byly urceny soufadnice bodl vnitinich prostor domi
zam¢efovaného podloubi. Dale byly zaméfeny identické body, které slouzily
pro transformaci méfeni do mistniho systému naskenovaného mracna. Métenim byly také
ovéreny tii lokalni vyskové body. Pred samotnym méfenim byla urcena ¢ast méticke sité.
Jednotlivé vchody do objektii byly zpfistupfiovany postupné, a tak nebylo mozné
meéfickou sit’ vytvorit najednou. Méfeni na jednotlivé body sit€¢ probihalo ve dvou
polohach v rezimu Standard. Podrobné body byly méfeny v rezimu Tracking a v jedné
poloze. Body méfické sité byly ¢islovany od ¢isla 5001. Identické body byly ¢islovany
od ¢isla 4001. Podrobné body v jednotlivych vstupech byly ¢islovany ve stovkové fadé
podle potadi méteni. Prvni méteni tedy zacinalo ¢islem bodu 101 a kazdé nasledujici
méteni podrobnych bodi cislem o 100 vétsim. Celkem bylo zaméfeno 11 vchodi.
Nékolikrat nebyly ze stanoviska méfické sité viditelné dulezité ¢asti vnitinich prostor.
V téchto piipadech byly vyhotoveny pomoci rajonu dalsi stanoviska uvnitt objekti.
Podrobné body byly zaméfovany i pro studenty Fakulty architektury CVUT, ktefi
absolvovali pfedmét Pamatkova péce III. K meétfeni polarni metodou studenti méftili
omérné k vytvoreni pldorysti vstupii. Tato spoluprice méa za cil, vytvorfit takové
podklady, na zaklad¢ kterych bude mozné zachytit polohu sousednich zdi jednotlivych

domt a Iépe porozumét genezi vyvoje zastavby.
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(. Kanceldrské prace

Schéma zpracovani dat

Stazeni jednotlivych skent

v

Automaticka registrace skent

v

Ruc¢ni registrace skent

v

Filtrace Sumu a duplicitnich bodi

v

Ofez mrac¢na boda Technické nivelace

v v

Transformace mrac¢na do mistniho systému pro vytvoreni vykrest

v

Mg¢feni polarni metodou Vytvoteni ezl a pohled

v v

Tvorba vykrest (pudorys, podélny fez)

Uprava vystuptl

v

Export vystupt

7.1 Stazeni dat ze skeneru

Po vyhotoveni skeni byl skener pfipojen pies rozhrani WI-FI Kk pocitaci. Pomoci
programu BLK360 Data Manager byly oznaceny vSechny skeny ve vnitini paméti
skeneru a stazeny na disk pocitace. Bylo stazeno celkem 59 skend. Behem skenu ¢. 23
bylo potfeba vyménit baterii. Do skeneru se uloZila jen ¢ast snimku bez mra¢na bodd.

Soubor tohoto skenu nebyl déle vyuzit a byl smazan.
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(.2 Registrace skenti

K registraci jednotlivych skeni byl pouzit program Leica Cyklone REGISTER 360.
V programu byl zalozen novy projekt. Do nového projektu byly naimportovany
jednotlivé skeny ve formatu .blk. Import byl proveden v levé Casti zalozky IMPORT
pies tlacitko Browse Files. Prava ¢ast zalozky IMPORT obsahovala nastaveni registrace
skent. V ptipad¢ této prace byla zvolena automaticka registrace mracen bez pouziti teréi.
V nastaveni byla zaSkrtnuta jen moznost Auto Cloud. Samotna registrace byla spusténa

cervenym tlacitkem v pravém dolnim rohu zalozky IMPORT.

IMPORT REVIEW AND OPTIMIZE FINALIZE REPORT

@ @ Havelska_2

l‘bmmm REVIEW AN IMIZ E/HMLIZE

e o g @ A & - | B- % -

Obrdzek 26 — Jednotlivé zdlozky v programu Cyclone

Po dokonceni registrace program oznamil uspésné dokonceni registrace a sam presel
do dalsi zalozky REVIEW AND OPTIMIZE. Jak nazev zalozky napovida, v této zalozce
bylo mozné mracno prohlédnout, zkontrolovat registraci a dale s mracnem pracovat.
Prava cast zalozky REVIEW AND OPTIMIZE po registraci obsahovala shrnuti registrace
vypsanim procentualniho piekryti a propojeni skenti a chyby celého svazku, ktera Cinila
0,006 m (Obrazek 53). Ciselné hodnoty byly doplnény i barvou, ktera signalizovala miru
tolerance chyb. Napojeni jednotlivych skenti bylo graficky zkontrolovano pomoci
zobrazeni TruSlicer. V tomto rezimu zobrazeni program obarvil kazdé stanovisko jinou
barvou a naskenované mra¢no zobrazil do pudorysu. UZivatel ma k dispozici dva jezdce,
kterymi miiZze vytvorit fez pldorysem. Jednim jezdcem méni tlouStku fezu, druhym
umisténi fezu. Pfiblizenim a zménou vySkového umisténi fezu bylo zkontrolovdno
napojeni jednotlivych obarvenych skenll v n€kolika mistech. Pfi kontrole nebyla nalezena
zavazna chyba. Mirné odchylky v piekryti jednotlivych barev byly pozorovany
na mistech, kde bylo b&hem skenovani manipulovano s dveimi. Zadné dalsi Gpravy
nebyly v tomto programu provedeny a ¢ervenym tlad¢itkem umisténym v pravém dolnim

rohu zalozky byla potvrzena registrace skent.
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V dalsi zalozce FINALIZE byla provedena finalni kontrola, znovu zkontrolovany
odchylky a prekryti skent. Tlacitkem Accept byla kontrola potvrzena. Program nasledné
ptikrocil k poslednimu kroku, k exportu.

Program v posledni zalozce REPORT nabidl uzivateli protokol o celém procesu
registrace. V pravé casti posledni zalozky bylo k dispozici nastaveni exportu. Program
nabizi n¢kolik formatt. Horni ¢ast je urcena pro nastaveni exportu protokolu, dolni pro
export mra¢na bodd. Zakliknutim vybranych formatt, nastavenim cest pro ulozeni a
naslednym zmacknutim Cerveného tlacitka v pravém dolnim rohu zalozky byl spustén
export (viz Obrdzek 27). Pro dal$i zpracovani byly zvoleny formaty typu PTX a E57.
Program dale nabidl vyexportovat registrované mrac¢no jako celek do jednoho souboru
nebo exportovat kazdé stanovisko do souboru vlastniho. Uspé&iné se vyexportovaly jen
soubory celého kompletniho mrac¢na. P exportu jednotlivych stanovisek do formatu E57
se vyexportovalo 59 soubort s celkovou velikosti 0 kB. Z ¢asovych divodu nebyl tento

problém dale feSen.

Pubksh Options

TruView Image Resolution

View Locd
D TruView Enterpnse

loud

O

0
0 sets
O
O
O
(]«

Obrdzek 27 — Moznosti nastaveni exportu
registrovaného mracna
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7.3 Orez mracna

Registrované mracno bylo ve formatu .ptx nahrano do softwaru CloudCompare
(File -> Open). Pro ofezavani mrac¢na slouzi v programu CloudCompare funkce v menu
Edit -> Segment. Vybrané mrac¢no Ize ofiznout pomoci libovolného polygonu (polygonal
selection) nebo obdélnikem (rectangular selection). Pravym kliknutim uzivatel definuje
vrcholy polygonu nebo dva protilehlé vrcholy obdélnika. Po vybéru oblasti obdélnikem
nebo polygonem, uzivatel definuje vnitini nebo vnéjsi oblast. Definovana oblast je
po kliknuti na fajfku odebrana z ptivodniho mracna a tvofi samostatny soubor v databazi

programu.

7.4 Filtrace sumu a duplicitnich bodii

Pro smazani duplicitnich bodd byla v programu CloudCompare pouzita funkce
v menu Tools -> Others -> Remove duplicate points. V nastaveni funkce byla nastavena

minimalni vzdalenost mezi body na hodnotu 0.010 m a funkce spusténa.

=3 o a
zz;eR~0B

pPOE D

Obrazek 28 — PouZziti funkce Remove duplicate points
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Pro filtraci Sumu program CloudCompare nabizi funkci v menu
Tools -> Clean -> Noice Filter. V nastaveni funkce byl nastaveno okoli bodu pomoci

radiusu. Znovu byla nastavena hodnota 0.010 m.

MNeighbors
() Points (kNN) (@) Radius (Sphere)
6 % [0.010000 :

Max error

(®) Relative () Absolute
1000000 :

Remaove isolated points

oK. Cancel
Obrazek 29 — Pouziti funkce Noice Filter Obrdazek 30 — Nastaveni funkce
Filter Noice

Oftezem a filtraci Sumu a duplicitnich bodl byla celkova velikost souboru mracna
bodli zmensena z 21,784 GB na 599 MB. Celkovy pocet bodu klesl z 535 688 254 na
16 730 718 bodu. Velikosti souboru se zmensila 0 72,5 %, pocet bodti mra¢na klesl o
96,88 %.

1.5 Vypocet technické nivelace

Me¢ticky zapisnik technické nivelace vedeny béhem méfeni byl vypocitan ihned
po samotném méfeni. Pro kazdy nivelacni potad bylo vypocteno vysledné prevyseni mezi
pocatecnim a koncovym bodem. Dale byly secteny hodnoty méieni tam a hodnoty méieni
zpét. Tyto dva soucty byly od sebe odeCteny a bylo vypocteno meétfené prevyseni.
Nasledné byl vypocitan rozdil pfevyseni vypocitaného z koncového a pocatecniho bodu

s prevysSenim zméfenym. Tato hodnota byla porovnana s mezni hodnotou.

Nivelacéni porad k ovéfeni nivela¢nich bodu

Vypoctené prevyseni: 0,261 m
Zmétené prevySeni: 0,262m
Délka poradu Lkm: 0,042 km

Vypocet mezni hodnoty pro technickou nivelaci:

L
Ay = 40 - % = 5,80 mm

Meéteni nepiekrocilo mezni odchylku.
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Nivelaéni pofad K pfipojeni mra¢na do systému Bpv

Vypoctené prevyseni: 0,051 m
Zmétené prevysSeni: 0,050 m
Délka poradu Lkm: 0,250 km

Vypocet mezni hodnoty pro technickou nivelaci:

Meéfteni nepiekrocilo mezni odchylku.

Technickou nivelaci byly zamétfeny tyto vysky:

L
Ay = 40 - % = 14,14 mm

CB vySka Bpv [m] poznamka
101 195,009 sokl
102 195,014 sokl
103 194,711 cep
104 194,685 prah
105 194,358 vstup (sklep)
106 194,314 cep
107 194,707 cep
108 194,596 cep
109 194,680 cep
110 194,167 prah
111 194,171 prah
112 194,162 prah

Tabulka 4 — Vysky nivelovanych bodii
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7.6 Vypocet polarni metody

Vypocet polarni metody probihal
v programu Groma. Do Gromy byl nahran
zapisnik méfeni ve formatu .sdr. Nejprve
bylo pomoci funkce Zpracovani zapisniku
zpracovano meéfeni v obou  polohach
(priloha protokol_zapisnik.pro). Dale byl
zaloZen novy seznam soufadnic. Soufadnice
X bodu 5002 byla zvolena 5000, soutadnice
Y 1000. Soutfadnice Y bodu 5003 byla
zvolena 1000, souradnice X 5000 + zméfena
vzdalenost mezi body 5002 a 5003.
Vysledné soufadnice bodii méficke sité byl

vypocteny postupné funkci poldarni metoda.

Soubor:
|D:\skola\DP\méFeni\HAVELSKA mes

Teodolit: Opravit:
(@ Vaechny

(O Oznacené

[}\Iezném)" teodolit Nastaveni ...

Opravy:

[[] Redukovat &ikmé délky na vodorovné
Zpracovat méreni v obou polohach
[[] Redukovat sméry

Opravit indexovou chybu

[] Opravit refrakci

[ Wypoc itat prevyseni

[[] Redukovat prevyieni na spojnici stabilizaénich znadek
Zpracovat opakovana méreni

Zpracovat obousméme mérené délky a prevyseni

Nastaveni refrakce...

Volby:
[[] Pouze do protokolu

Napovéda

Opravit

Obrazek 32 — Zpracovani zapisniku
v programu Groma 12

Po vypoctu soutadnic bodti méfické sit€¢ byly funkci poldrni metoda davkou vypocteny

soutfadnice podrobnych a identickych bodi.

Obrazek 33 — Schéma identickych bodii zamérenych poldrni metodou
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1.7 Transformace souradnic podrobnych bodii

Polarni metodou bylo zaméfeno 9 identickych bodi, které slouzily k transformaci
méteni do stejného systému jako bylo naskenované mracno. Soutradnice stejnych bodi
byly odecteny z mracna. V programu Groma byly vytvoreny dva seznamy soufadnic.
Jeden obsahoval soutfadnice z mrac¢na, druhy soufadnice vypoétené z polarni metody.
Funkci Transformace souradnic v menu Vypocty byl vypoclten transformacni kli¢
(priloha transformacni_klic.key). Jelikoz byly polarni metodou doméfovany vnitini
prostory a mra¢no boda jiz bylo umisténo v mistnim systému, byly transformovany
soufadnice podrobnych bodit do mistniho syst¢ému mra¢na. Do vypoctu byly zahrnuty
vSechny métené body. U bodu ¢islo 4005 byly podezicle vyssi odchylky (viz obrazek 34).
Bod 4005 byl z vypoctu vyloucen. Tento bod byl $patné zvolen, protoZze v mracnu jej
nebylo mozné jasné€ definovat. Nasledné byl vypocteny transformacni kli¢ aplikovan na
vypoctené body z méfeni polarni metodou. Vysledné souradnice X a Y bodu byly pro
korektni praci v CAD programech vynasobeny -1 pomoci funkce Hromadnda zména.
Vysledny seznam soufadnic byl vyexportovan do textového souboru ve formatu XYZ.txt

(viz priloha seznam_sourdnic.txt).

Identické body:
Bod dy dax | Prede:] |

w02 o012 ooz | Cise: [ 3001]

3003 -0.003 -0.006 8’460‘_'

300¢ 0028 0015 57200
O 3005 -3231 0462

3006 0019  0.001 Piedé_::]
7] 3007 0002 -0.007 )
3008 0003 0003 | Cisk:

e 997630 §
Kic Pridat Ubrat x 501 5.954J &
Typ transformace: Transformovéno: Ulogt Kli&
O Shodnostni % bodl  Iiagiskic
@® Podobnostni [[] Statisticky test id. bodti
. [] Protokolovat i vypnuté body
O Afinni Protokolovat oboje &isla bodl
O Usivatelska | .| []Protokol o pfifazeni zmény

[[] Testovat rozmisténi bodd
Transformovat i identické body

[ inverzni (zpétna) transformace
Seznamy souradnic:

Vstup: [D:\skola \DP\méreni\souradnice.crd |

Vystup: ‘D:\ékola‘\DP‘méFeni\iransformované.crd |

[lgnorovat predéisli Jyhledani identickych bodu

Protokol XY <->xYy'| | Nova transformace Vypocet

Obrdzek 34 — Vypocet transformacniho klice
v programu Groma 12
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7.8 Tvorba vykresii

Zpracovani vykrest probihalo v programu MicroStation. Nejprve bylo potieba
nastavit prostfedi tohoto programu. Byly zaloZzeny celkem 3 modely. Model pro vykres
pudorysu, model pro vykres podélného fezu a pomocny model. Dale byly nastaveny
vrstvy. Tabulka vrstev obsahuje nazev vrstvy, piislusnou barvu, typ a tloustku ¢ary. Jako
vzor pro definici vrstev a nasledné kresleni jednotlivych prvka slouzila publikace Citanka
vykresu ve stavebmictvi a Meéricka dokumentace historickych staveb pro priizkum

V pamatkové péci. [26], [11]

Nazev vrstvy Typ €ary Tloust’ka ¢ary Barva vrstvy
Rez 0 (pIna) 2 3 (Servend)
Prvky nad fezem 6 (Cerchovana 0 7 (tyrkysova)

se dvéma teckami)

Prvky pod fezem 0 (plnd) 0 2 (svétle zelena)
Klenba 4 (Cerchovana) 0 183 (tmaveé zelena)
Profil 4 (Cerchovana) 2 6 (oranzova)
Vysky 0 (plna) 0 1 (modra)

Koty 0 (plna) 0 1 (modra)

Koty klenby 0 (plna) 0 1 (modrd)
Pomocné popisy 2 (¢arkovana) 0 0 (bila)
Soutadnicové kiizky | 0 (plnd) 0 0 (bila)

Tabulka 5 — Tabulka vrstev

Skala tloustek a typt &ar:
Tenka ¢ara — VIDITELNE HRANY POD I NAD ROVINOU REZU
Tlusta ¢ara — REZ KONSTRUKCEMI STAVBY (primik fezové roviny a stén)
Velmi tlusta ¢ara — VYZNACENI PRUBEHU REZU, HREBENY STRECH
Tlusta plna ¢ara — REZ KONSTRUKCEMI STAVBY (prinik fezové roviny a stén)
Tenké plna ¢ara — VIDITELNE HRANY A OBRYSY POD ROVINOU REZU
Tenk4 Garkovana ¢ara — SKRYTE HRANY A OBRYSY POD ROVINOU REZU
Tenka Gerchovana ¢ara s dvéma te¢kami — HRANY NAD ROVINOU REZU
Tenka &erchovana ¢ara— SKLOPENA CELA KLENEB
Tlusta Gerchovana ¢ara — VYZNACENI PRUBEHU REZU
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V programu CloudCompare byl vyhotoven ofez mra¢na jako podklad pro vypocet
natoceni. Cilem natoceni je umistit soufadnicové osy tak, aby co nejlépe kopirovaly
pribéh loubi. Tento fez byl vyexportovan do formatu .dxf a tento soubor byl referencné
pfipojen do pomocného modelu. V kreslicim okné byly definovany pomocné
soutfadnicové osy totozné S 0sami programu. V pfipojeném fezu byla vytvoiena pomocna
linie rovnobézna s vné&jsi fasadou domu €. p. 504. Dale byla vytvorena kolmice na tuto
linii. Pomoci funkce pfesunuti a natoCeni referenéniho vykresu byl referenéni vykres

presunut a natocen na puvodn¢ definované pomocné osy.

Obrazek 36 — Pomocné linie

Obrazek 35 — Umisteni do mistniho systému

Udaje o posunuti a natoéeni referenéniho vykresu poslouzily k transformaci celého
mrac¢na v programu CloudCompare. Z mé&feni technickou nivelaci a porovnanim
vyslednych hodnot vysek identickych bodu (viz Tabulka 4) s hodnotami vysek stejnych
bodl v lokalnim systému registrovaného mracna byl ziskan vyskovy rozdil obou systémtl.

Touto hodnotou bylo mrac¢no transformovano v ose Z.
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(@ Apply transformation ? X

Matrix x4 Axis, Angle Euler anales

Rotation axis

[x: 0.00000000 = [: 0.00000000 2| [z 1.00000000] :

Rotation angle (degrees)

[6.6712 deg. g

Translation

Ar

[: 8 11960.00000000 2| [v: 106.07800000 % [z: 195.40000000

Obrdzek 37 — Parametry transformacniho klice v programu CloudCompare

Ze spravn¢ umisténého mra¢na boda byly v programu CloudCompare vygenerovany
vicenasobné pudorysné a podélné fezy. Vytvofeni umoznil nastroj Cross Section.
Pro vytvoieni padorysného fezu byla v dialogovém okné nastavena hodnota soufadnice
Z na 1 cm, pro vytvofeni podélného fezu byla nastavena hodnota Y na 1 cm. Tim bylo
docileno fezu o velikosti 1 cm. Pro vygenerovani fezi po celé oblasti mra¢na byla zvolena
moznost Export multiple slices. Parametr Gap byl nastaven na 20 cm. Byly tedy
vygenerovany fezy po 20 cm. Rezy byly vyexportovany do formatu .dxf (piilohy
rez_pudorys.dxf a rez_podelny.dxf).

- «
0 ADIE
Box thickness Repeat dimensions
z
0 |ID?.6334533? = |
[ Extract contour(s)
v |20.47129822 g
Contour type Full
z |D,DD'399999 = | Max edge length | 1.097864 &
advanced | multi-pass
project slice(s) points on their best fit plane
Contour Slices ) .
split contour(s) on longer edges
visual debug mode
Q 0 i i Other options
Gap 0.200000 =
= I = r=10r [] random colors per slice {will overwrite existing color!)
0O & & D 5
Shift box
= | ¥ | -2 +
OK Cancel
Obrdazek 38 — Tvorba rezu Obrazek 39 — Nastaveni Multiple slices

Do modelu ptdorysu byl referenéné pripojen soubor .dxf s vytvofenymi fezy
padorysu. Jednotlivé prvky vyobrazené v fezu byly obtahovany a kresleny do diive
nadefinovanych vrstev vykresu. Jako rovina fezu byly zvoleny vrstvy dxf souboru, které

se nachazely od 80 cm do 120 cm nad urovni terénu. Kresleni prvki pod nebo nad rovinou
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fezu bylo docileno vypinam a zapinanim jednotlivych vrstev. Soucasné bylo nahlizeno

I do mrac¢na bodu v programu CloudCompare a na potizené fotografie.

Obrdzek 40 — Tvorba vykresu v programu MicroStation

Tvorba vykresu podélného fezu vychézela zjiz vytvoreného vykresu ptdorysu.
Priitbéh roviny podélného fezu byl definovan vrcholy kleneb podél celého podloubi
a zkonzultovan se zadavatelem (viz Obrdzek 41). Bylo vyuzito referen¢niho pfipojeni
modelu ptdorysu a referen¢niho ptipojeni dxf souboru s podélnymi fezy. Z lomovych
bodi ptidorysu byly spoustény piimky, tim byla definovana jejich poloha ve vykresu fezu
vose X (viz Obrdzek 42). Poloha vose Y byla definovana z pfipojeného mracna
podélného fezu nebo odeétenim soufadnice Z z mra¢na bodt v programu CloudCompare.
Jelikoz rovina podélného fezu byla nékolikrat zalomena, bylo potieba model pidorysu

referencné pripojit nékolikrat a pokazdé jej natocit prave podle pritbé¢hu roviny fezu.

A == 4

Obrdzek 41 — Priibéh podélného rezu A
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Obrazek 42 — Kresba rezu

Béhem kresby vykresi v programu MicroStation byly pouzity tyto funkce:
e Umistit asecku
e Umistit oblouk
e Konstrukce tsecky pod aktivnim tthlem
e Umistit text
e Rozbit prvek
e Protahnout prvek
e Ofiznout k pruseciku
e Ofiznout podle prvku
e Kopirovat, pfesunout, presunout rovnobézn¢, otocit
o Kotovat vzdalenost

e Prevzit atributy prvku, Zménit atributy prvku
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Béhem kresby vykres v programu MicroStation byla v nastaveni vykresu zapnuta
centimetrovd mifizka. Diky této funkci se kresba na tuto miizku pfichytavala

a zjednodusilo se tim konstruovani prvkd.

Mastaveni vykresu

Kategorie Nastavit parametry mrizky

Aktivni dhel MFizka _OK
Aktiw'ﬂi Pomér zvétdeni Hlavni/mFizka | 0.010 —
EDT?hT:tIS Modul mfigky | 10 Stomo
Barva Typ mfizky |Pravodhla  ~

Atributy prvku

Ohrada Pomér (Y/¥) | 1.000000

MFizka A

lzometrie Natogeni: | Pohled o

Prepinace

Najezd

Proudové kresleni
Pohledy

Pracovni jednothky

Popis vybrané polozky
Zvolte kategori, kterou cheete prohlédnout.

Obrdzek 43 — Nastaveni mrizky vykresu v programu MicroStation

Po dokonceni kresby jednotlivych prvku vykresu byl vykres doplnén o rozmérové
koty, koty Kleneb a vyskové koty. Veskeré koty jsou zobrazeny v modré barve, aby
nesplyvaly s kresbou vykresu. Protoze povrch chodniku je tvofen dlazbou a ma proménny
pribéh, byly vyskové koty tvofeny pomoci absolutnich vysek sytému Bpv. Dale byl
vykres doplnén o soufadnicové kiizky. O exportu vykresu pojednava kapitola 7.10.
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7.9 Porovnani obloukii kleneb podloubi ¢. p. 507

Béhem rekognoskace byla zadavatelem vyslovena otazka, jak moc se svou geometrii
podobaji oblouky kleneb loubi domu ¢. p. 507 (viz Obrazek 44). Toto porovnani mize
dale slouzit k rekonstrukci postupu praci, zda byla pouzita stejnd konstrukce pro oba
oblouky. Pro porovnani byl vyuzit program CloudCompare. Z naskenovanych dat byla
ofiznuta ¢ast loubi. Tato ¢ast byla nasledné rozdélena v ptli mezi oblouky kleneb. Zustaly

tedy vnitini ¢asti obloukd a pilift.

Obrazek 44 — Porovndvana oblast obloukii kleneb

Tato dvé mra¢na byla vloZzena do funkce registrovani mracen (z pohledu ulice

Havelské bylo jako referen¢ni mracno zvoleno mra¢no levého oblouku — vys$siho oblouku

klenby).
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[ (e
PR SGEFURX S @t n.e

Obrazek 45 — Umisténi funkce automatické registrace v programu CloudCompare
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Pfi tomto pokusu se algoritmus snazil mrac¢na spojit ptes plochy piliit. Pro ucel
porovnani oblouktl byl tedy vysledek nevyhovujici, protoze pribéhy obou obloukt

nem¢ély po registraci zadny spole¢ny bod.

Pii druhém pokusu byly pied registraci mraden odstranény c¢asti piliia (od paty
klenby smérem k zemi). Znovu byla spusténa automaticka registrace mracen. Vysledek
algoritmu byl mnohem lepsi (viz Obrdzek 46). Ob&é mra¢na méla spole¢ny bod pfiblizné

ve vrcholu Klenby.

1 -]

P sl

1 S8QELEOED

Obrdazek 46 — Vysledek druhé automatické registrace

Pro zobrazeni odchylek obou mraden byla pouzita funkce pro vypocet

vzdalenosti Compute cloud/cloud distance.
o
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Obrazek 47 - Umisténi funkce Compute cloud/cloud distance v programu
CloudCompare

V nastaveni zobrazeni pfipojovaného mracna byl zménén typ zobrazeni z RGB

na Scalar field. Bylo tedy mozné graficky odecist odchylky (viz Obrazek 48).
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Obrdzek 48 — Grafické zobrazeni vypoctenych vzddlenosti cloud/cloud

Ze zobrazenych dat bylo vidét, ze algoritmus pouzil kregistraci mracen plochy
fasady loubi. Byl tedy proveden dalsi pokus. Mracna byla ofiznuta Cist¢ jen na vnitini
Cast klenby. Byla zopakovana registrace mracen a vypocet vzdalenosti mezi body obou

mracen.

Obrazek 49 — Grafické zobrazeni vypoctenych vzdalenosti cloud/cloud po 2. pokusu (pohled
shora)
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Obrdzek 50 - Grafické zobrazeni vypoctenych vzddlenosti cloud/cloud po 2. pokusu (frontalni
pohled)

Z posledniho porovnani je jasné, ze vnitini tthel kleneb neni totozny. Horni pohled
na pfipojené mracno naznaCuje, Zze pfipojovanad klenba mirné pada,
protoze barevné zobrazené odchylky mirn€¢ uhybaji do stran. Po ukdzce vysledka
a nasledné konzultaci s doc. Ing. Michaelem Ryklem, Ph.D. byl navrzen dalsi pokus
o porovnani — nedrzet se obloukt jako celku, ale oba oblouky kleneb rozdélit na pravou

a levou cast a tyto ¢asti vzajemn¢ porovnat.

Registrace levé 1 pravé ¢asti obloukt probéhla v poradku. Pfi vypoctu vzdalenosti
hodnoty nepiekroc€ily u levé ¢asti 5 cm u pravé ¢asti 7 ecm. Vysledné odlehlosti obou

mracen jsou graficky zobrazeny barevnou hypsometrii (viz obrdazky 51 a 52).

Vysledky porovnani geometrie obloukd nevyvraci teorii, ze bylo pouzito stejného
tvaru bednéni pro stavbu obou obloukt kleneb. Jelikoz se podobaji jednotlivé Casti
oblouk, je mozné¢, Ze se bednéni sklddalo ze 2 Casti. Pti stavbé jednotlivych kleneb byly

k sob¢ ¢asti sestaveny jinym zptisobem a ve vrcholu byly doplnény vrcholovymi klenaky

odli$nych tvart.
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Obrdzek 51 - Grafické zobrazeni vypoctenych vzddlenosti cloud/cloud po 3. pokusu — prava édst
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Obrdzek 52 — Grafické zobrazeni vypoctenych vzddlenosti cloud/cloud po 3. pokusu — leva cast
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7.10 Export vystupii

Vystupem této prace je mra¢no bodul, porovnani obloukti kleneb loubi domu ¢&. p.
507 a vykresy pudorysu a podélného fezu loubi domu €. p. 504 — 512 v digitalni 1 tisténé
podobé. Veskeré vystupy jsou uloZzeny na SD karté. Struktura souborti je popsana

v kapitole Obsah SD karty.

Mraéno bodu

Vy¢isténé a ofiznuté mrac¢no bylo vyexportovano do formatu .las. Vysledné mra¢no
bylo vyexportovano s hustotou bodd 1 cm.

Priloha: mracno_bodu_1cm.las

Porovnani oblouku

Vystupem porovnani obloukt jsou dva rastrové soubory vytvorené funkci Render to
File a soubor ve formatu .bin s celym projektem z programu CloudCompare.

Prilohy: porovnani_oblouku.bin, porovnani_prava.png, porovnani_leva.png

VyKkres pudorysu a podélného iezu

Pro finalni export vykrest z programu MicroStation byl vytvofen model typu arch.
Byl zvolen format 4xA4 a 5xA4. V tomto modelu byla vytvoiena popiska, ram vykresu,
severka, grafické meéfitko a dalsi doplnkové prvky. Do jiz piipraveného archu byl
referen¢né piipojen hotovy model vykresu pudorysu v méfitku 1:50. Byly vypnuty
pomocné vrstvy piipojeného vykresu a findlni vykres byl vytistén do formatu pdf.
Obdobn¢ byly vyhotoveny vykresy podélného fezu. Celkem se vykres rozdélil na tii ¢asti.

Prilohy: 01 pudorys_1.pdf, 02_pudorys 2.pdf, 03 pudorys 3.pdf, 04 rezA 1.pdf,
05 rezA 2.pdf, 06 rezA_3.pdf

Modely ptdorysu i podélného fezu byly vyexportovany do CAD souboru formatu
dwg a dgn. Modely typu arch nebyly exportovany.

Prilohy: vykres_pudorys.dgn, vykres_pudorys.dwg, vykres rezA.dgn, vykres rezA.dwg

51



% CESKE VYSOKE UCENI TECHNICKE V PRAZE

8. Zhodnoceni presnosti

Presnost a kvalita automatické registrace skeni byla né¢kolikrat kontrolovana
riznymi metodami. Tato kapitola popisuje jednotlivé metody kontroly a jejich vysledky.
Jako prvni zhodnotil kvalitu registrace protokol 0 registraci mra¢na v programu Leica
Cyclone REGISTER 360. Dale bylo ovéteno vyskové umisténi registrovaného mra¢na
technickou nivelaci. Nakonec bylo polohové umisténi registrovaného mracna

zkontrolovano méfenim totalni stanici polarni metodou.

Automaticka registrace skeni

Celkova automaticka registrace skent (viz kapitola 7.2) v programu Leica Cyclone
REGISTER prob¢hla s celkovou primérnou chybou 0,006 m a s praimérnym piekrytim
jednotlivych skenti 44 %. Protokol (priloha protokol_registrace.pdf) dale obsahuje
informace o propojeni jednotlivych skenii. V této casti protokolu je vidno, Ze stanoviska
47 a 53 se jako jedina propojila s chybou vétsi nez 15 mm. Chyba propojeni Cinila 18

mm. V seznamu je jejich propojovaci linka jako jedina oznacena Zlutou barvou.

Overall Quality

Error Results for Bundle 1

Bundle Error
i 0.006 m Vv
Link Count: 327

Setup Count: 59

Strength: 83% Overlap Strength
Overlap: 44 % 4% J 83%

Cloud-to-Cloud Target Error
. Max error of 0.015 m. Max error of 0.020 m. . Error greater than 0.020 m.

Obrazek 53 —Hodnoceni kvality registrace mracna
v protokolu o registraci mracna

Link 298 BLK360_3503293_Setupl2 BLK360_3503293_Setup56 19 % 0.012 m
Link 299 BLK360_3503293_Setup52 BLK360_3503293_Setup54 57 % 0.008 m
Link 300 BLK360_3503293_Setup47 BLK360_3503293_Setup53 15 % 0.018 m
I Link 301 BLK360_3503293_SetupS5 BLK360_3503293_Setup57 47 % 0.009 m

Obrizek 54 — Cist seznamu propojovacich linek z protokolu o registraci mracna
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Ovéreni vySkového umisténi registrovaného mrac¢na

Jednou z nevyhod 3D skeneru Leica BLK 360 je absence jakékoli libely. Pfistroj je
vybaven IMU jednotkou, ktera umoznuje automatickou orientaci pii naklonu az 5°.
Registrované mracno bylo zkontrolovano métenim nékolika identickych bodi technickou
nivelaci (viz kapitola 6.4). Toto méfeni provétilo sklon jen od osy Z. Z namétenych
a z odectenych vySek z mracna bodl byly vypocteny rozdily vysek, jejich primér
a nasledné¢ odchylky od priméru. Z vypoctenych hodnot je patrné, ze odchylky

systematicky nenartstaji a jsou spiSe nahodilé a v souladu s piesnosti méfeni a odeétu

vySek z mracna (viz Tabulka 6).

5 rozdil Odchylky
CB | vyska Bpv [m] | vy$ka (mra¢no bodi) [m] | vySek[m] [m]
101 195,009 -0,40 195,41 -0,01
102 195,014 -0,39 195,40 0,00
103 194,711 -0,70 195,41 -0,01
104 194,685 -0,70 195,39 0,02
105 194,358 -1,06 195,42 -0,02
106 194,314 -1,11 195,42 -0,02
107 194,707 -0,69 195,40 0,00
108 194,596 -0,81 195,41 0,00
109 194,68 -0,73 195,41 -0,01
110 194,167 -1,22 195,39 0,01
111 194,171 -1,21 195,38 0,02
112 194,162 -1,22 195,38 0,02

Tabulka 6 — Odchylky vyskovych rozdili

Obrazek 55 — Schéma rozmisténi nivelovanych bodu
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Technicka nivelace

Nivelacéni potrad k ovéfeni nivela¢nich bodu

Vypoctené prevySeni: 0,261 m
Zmétené prevySeni: 0,262m
Délka potadu Lkm: 0,042 km

Vypocet mezni hodnoty pro technickou nivelaci:

L
Ay = 40 - % = 5,80 mm

Me¢fteni nepiekrocilo mezni odchylku.

Nivelaéni porad k pfipojeni mra¢na do systému Bpv

Vypoctené prevyseni: 0,051 m
Zmgéiené pievyseni: 0,050 m
Délka potadu Lkm: 0,250 km

Vypocet mezni hodnoty pro technickou nivelaci:

L
Ay = 40 - % = 14,14 mm

Meéieni nepiekrocilo mezni odchylku.

Ovéreni polohového umisténi registrovaného mrac¢na

Polarni metodou bylo zaméteno i nékolik identickych bodt, které slouzily
K transformaci méfeni do systému naskenovaného mra¢na (viz kapitola 6.5).
Transformacni kli¢ (ptiloha transformacni_klic.key) vypoéteny k této transformaci nam
muze poskytnout nahled i na spravné vytvoienou registraci skend v prostoru. Maximalni
odchylka registrovaného mra¢na vi¢i méfeni polarni metodou v soutadnici X ¢ini 29 mm,

Vv soufadnici Y 19 mm (viz Tabulka 7).

54



% CESKE VYSOKE UCENI TECHNICKE V PRAZE

CB dX [m] | dY[m]
4001 0,001 0,007
4002 0,009 0,013
4003 -0,006 0,007
4004 -0,029 0,016
4006 0,020 -0,003
4007 0,003 -0,011
4008 -0,001 -0,010
4009 0,003 -0,019

Tabulka 7 — Souradnicové rozdily identickych bodii

Obrazek 56 — Schéma rozmisténi identickych bodii

Polarni metoda
Z protokolu (priloha protokol_zapisnik.pro) o zpracovani zapisniku v programu
Groma vyplyva, Ze méfeni v obou polohdch neobsahuje zadné podezielé ¢i chybné

meéieni. Rozdily obousmérné méfenych délek neptekrocily 3 mm.

Odhad kolimacni chyby: -0,0035 gon
Odhad indexové chyby: 0,0014 gon

Po vypoctu polarni metody davkou programu Groma byl vyhotoven protokol
(priloha polarni_metoda.pro). Nejvétsi odchylky pii vypoctu byly u stanoviska 5009, kdy
maximalni oprava v délce ¢inila 7 mm, maximalni oprava orientace byla 0.007 gon. Tyto

opravy jsou v souladu s o¢ekavanou piesnosti.
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Laver

Vytycené cile v uvodu této prace se podatilo splnit. Pomoci skeneru Leica BLK 360
bylo naskenovéano loubi doma ¢. p. 504 — 512 v Havelské ulici v Praze 1. Naskenovana
mracna byla registrovana v programu Leica Cyclone REGISTER. Registrované mra¢no
bylo upraveno v programu CloudCompare. Z vysledného mra¢na a z dat namétenych
polarni metodou totalni stanici byl v programu MicroStation vytvotren vykres pudorysu
a vykres podélného fezu. Dale byla provedena analyza geometrie vybranych klenebnich

oblouku.

Vyhodu skeneru Leica BLK 360 vidim v jeho skladnosti, rychlosti skenovani
a jednoduchém ovladani pti skenovani pomoci jednoho tla¢itka. Nevyhodou je absence
libely. Diky tomu nema méfi¢ jasnou kontrolu nad horizontaci ptistroje. Dalsi nevyhodou
je komunikace pftistroje jen se zafizenim s operacnim systémem 10S. Bez tohoto zatizeni
tak neni mozna jakakoliv kontrola skenovani nebo zména parametrd skenovani.
Pii méfeni se také n€kolikrat vybila baterie. Vyrobce udava, ze métic¢e skener upozorni
tmav¢ zelenym blikanim signalizaéniho pruhu pii kapacité bateric < 20 %. Bohuzel
pii pfimém svitu slunce na skener neni odstin zelené barvy rozpoznatelny od bézné
zelené, kterd sviti pti pribéhu skenovani, a béhem méieni se stalo, ze se baterie vybila
béhem skenovani na stanovisku hned po pofizeni fotek. Nasledné se skener rozblikal
zluté, tim signalizoval GpIné vybiti baterie. Po vyméné baterie bylo méfeni na stanovisku
zopakovano. M¢feni, které obsahovalo jen nafocené fotografie, bylo pii stahovani dat
smazano. Nevyhodou je také komunikace s pocitacem pies rozhrani WI-FI. Stahovani

skentl tak trva delsi dobu a pfi stahovani se také miize vybit baterie piistroje.

Hlavni nevyhodou programu CloudCompare vidim v absenci funkce zpét. Jakakoliv
uprava tedy neSla vratit zpét. Bylo potieba si pfed kazdym pokusem mra¢no ulozit
do formatu .bin. Hlavni vyhoda je dostupnost programu v open-source verzi se

zakladnimi funkcemi k Gpravé mracen.

Samotné méfeni probihalo v dobé, kdy byla vyhlaSena rGzna nafizeni vlady
Vv prubéhu pandemie. To bohuZzel zapficinilo delsi prodlevy béhem méteni jednotlivymi

metodami. Napiiklad méteni polarni metodou, pro kontrolu registrovanych mracen

56



% CESKE VYSOKE UCENI TECHNICKE V PRAZE

a ziskani dat o vnitinich prostorech domd, prob¢hlo piiblizné 2 mésice po samotném
skenovani. Dle mého ndzoru by bylo lepsi veskera méfeni délat v co nejkrat§im casovém
horizontu. Na druhou stranu je vhodné si pfed méfenim vlicovacich bodi nebo
pred pfipojenim mra¢na do systému Bpv napt. pomoci nivelace ovéfit, zda body, pomoci
kterych chci méfeni pfipojit ¢i kontrolovat, naskenované mrac¢no obsahuje a jsou dobie

identifikovatelné. Dale bych béhem skenovani pofidil vétsi mnozstvi fotek pro lepsi

o 24
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Pouzité zkratky

NPU — Narodni pamatkovy tstav

Bpv — Balt po vyrovnani

RPAS — Remotely piloted aircraft system

S-JTSK — Systém jednotné trigonometrické sité katastralni

IMU — Inercial measurement unit (inercialni métici jednotka)
WLAN — Wireless local area network (bezdratova pocitacova sit’)
GPL — General Public License
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1) Text diplomové prace
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B Seznam vyhorovené dokumentace

Nazev Nazev souboru Pripona | Méritko | Format
Vykres pudorysu vykres_pudorys .dgn, .dwg | - -
Vykres podélného fezu vykres_rezA .dgn, .dwg | - -
Mrac¢no boda — 1 cm mracno_bodu_1cm | .las - -
Porovnani obloukti porovnani_oblouku | .bin - -
Porovnani pravé Casti porovnani_prava .png - -
oblouki

Porovnani levé casti porovnani_leva .png - -
oblouki

Pudorys — ¢ast 1 01_pudorys_1 pdf 1:50 5xA4
Pudorys — ¢ast 2 02_pudorys_2 pdf 1:50 4xA4
Pudorys — ¢ast 3 03_pudorys_3 pdf 1:50 4xA4
Podélny fez A — &ast 1 04 tezA 1 pdf 1:50 5xA4
Podélny fez A — ast 2 05 fezA 2 pdf 1:50 4xA4
Podélny fez A — Cast 3 06 tezA_ 3 pdf 1:50 4xA4
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C Mracno bodi
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E ykresy

01 — Padorys — cast 1
02 — Padorys — cast 2
03 — Padorys — cast 3
04 — Podélny tez A — Castl
05 — Podélny fez A — Cast2
06 — Podélny ez A — ¢ast3

Vykresy jsou volné priloZeny k této prdci.
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